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      Đề A 

 

ĐỀ THI LÝ THUYẾT 

HỘI THI GIÁO VIÊN DẠY GIỎI CẤP TRƯỜNG 

BẬC TIỂU HỌC - Năm học: 2012- 2013 

 

PHẦN I: Những câu hỏi trắc nghiệm kiến thức 

( Thời gian làm bài 40 phút. Gv đọc kĩ câu hỏi và đánh dấu vào đáp án đúng nhất trong phiếu trả 

lời.) 

Câu 1: Người đang giữ chức Bộ trưởng Bộ Giáo dục và Đào tạo nước ta hiện nay 

là:  

a. Nguyễn Thiện Nhân  b. Phạm Vũ Luận    c.Vũ Đình Chuẩn   d. Lê Tiến Thành 

Câu 2: Tỉnh Đồng Nai không tiếp giáp với tỉnh nào sau đây: 

a. Bình Dương      b. Tây Ninh        c. Bà Rịa – Vũng Tàu      d. Bình Phước 

Câu 3: Trong một hộp có 45 quả bóng gồm 20 quả bóng màu đỏ, 15 quả màu 

xanh và 10 quả màu vàng. Hỏi phải lấy ra bao nhiêu quả bóng để chắc chắn có 3 

quả bóng màu đỏ? 

a. 27                   b. 28                      c. 29                     d. 30 

Câu 4: Trong Quy định Chuẩn nghề nghiệp giáo viên Tiểu học có ba lĩnh vực đó 

là: 

a. Phẩm chất chính trị, đạo đức, lối sống, kĩ năng sư phạm. 

b. Phẩm chất chính trị, đạo đức, lối sống, kiến thức, kĩ năng sư phạm. 

c. Phẩm chất chính trị, đạo đức, kiến thức, kĩ năng sư phạm. 

d. Phẩm chất đạo đức, lối sống, kiến thức, kĩ năng sư phạm. 

Câu 5: Tháng an toàn giao thông quốc gia hằng năm được tổ chức vào: 

a. tháng 8          b. tháng 10           c. tháng 9              d. tháng 11 

Câu 6: Luật bình đẳng giới ra đời vào năm nào ? 

a. 2003                      b. 2004                  c. 2005                 d. 2006 

Câu 7: Câu nào sau đây “sai” ? 

a. Hạnh kiểm học sinh được đánh giá gồm hai loại: Đ và CĐ. 

b. Học sinh được đánh giá hạnh kiểm ba lần: HKI, HKII và cả năm học. 

c. Học sinh được đánh giá hạnh kiểm hai lần: cuối HKI và cuối năm học. 

d. Đánh giá hạnh kiểm cuối năm là quan trọng nhất. 

Câu 8: Khi lựa chọn và vận dụng các phương pháp dạy học cần căn cứ vào: 

a. Đặc điểm nhận thức của học sinh, năng lực trình độ sư phạm của giáo viên. 

b. Đặc trưng môn học. 

c. Điều kiện cơ sở vật chất, phương tiện dạy học. 

d. Cả 3 ý trên. 

Câu 9: Con sông chia đôi đất nước sau hiệp định Giơ-ne-vơ năm 1945 là: 

a. sông Gianh        c. sông Cầu    b. sông Hương     d. sông Bến Hải 

Câu 10: Việt Nam có 5 thành phố trực thuộc TW gồm những thành phố nào ? 
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a. Hải Phòng – Hà Nội – Đà Nẵng – Cần Thơ – thành phố Hồ Chí Minh. 

b. Hải Phòng – Đồng Nai – Đà Nẵng – Hà Nội – thành phố Hồ Chí Minh. 

c. Khánh Hòa – Nghệ An – Đồng Nai  – Hà Nội – Cần Thơ.  

d. Bình Dương – Hải Phòng – Đà Nẵng – Hà Nội – thành phố Hồ Chí Minh. 

Câu 11: Tìm thành ngữ tương đồng với thành ngữ “Chung lưng đấu cật”? 

a. Bốn biển một nhà.            c. Sống chết có nhau. 

b. Kề vai sát cánh.              d. Cả a,b đều đúng. 

Câu 12: Hai hình vuông có chu vi gấp nhau 5 lần. Hỏi diện tích chúng gấp nhau 

bao nhiêu lần ? 

a. 5 lần                 b. 10 lần          c. 20 lần           d. 25 lần              

Câu 13: Một trong những điểm mới chủ yếu trong nội dung chương trình Giáo 

dục Tiểu học là: 

a. Tăng nội dung lí thuyết các bài học. 

b. Tăng nội dung thực hành, vận dụng. 

c. Tăng số lượng môn học. 

d. Tăng thời gian giáo dục ở từng vùng miền khác nhau. 

Câu 14: Tiếng có 3 bộ phận, bộ phận bắt buộc phải có trong tiếng là: 

a. Âm đầu và thanh.               c. Âm đầu và vần. 

b. Vần và thanh.                     d. Âm đầu, vần và thanh. 

Câu 15: Hãy cho biết địa chỉ mail nào sau đây là địa chỉ đúng quy cách ? 

a. nguyenvana@gmail.com  ***            c. nguyenvana@@gmail.com 

d. 123nguyen – a@gmail                    b. nguyen van a @gmail.com 

Câu 16: Theo tinh thần đổi mới phương pháp, việc dạy học môn Đạo đức dựa 

vào: 

a. Trách nhiệm của học sinh.              c. Quyền trẻ em.                    

b. Bổn phận của học sinh.                   d. Trách nhiệm và bổn phận của học sinh. 

Câu 17: Văn miếu Trấn Biên ( phường Bửu Long, thành phố Biên Hòa tỉnh Đồng 

Nai ) xây dựng vào năm: 

a. Năm 1698 – do Thống suất Nguyễn Hữu Cảnh vào xứ Đồng Nai xây. 

b. Năm 1715 – do chúa Nguyễn Phúc Chu sai Trấn thủ Nguyễn Phan Long cùng Phạm 

Khánh Đức xây. 

c. Năm 1998 – nhân dịp kỉ niệm “300 năm Biên Hòa Đồng Nai” 

d. Năm 1852 – vào đời vua Tự Đức. 

Câu 18: câu văn dưới đây có bao nhiêu từ ? 

Tiếng cô giáo trang nghiêm mà ấm áp. 

a. 5 từ                          b. 6 từ                   c. 7 từ                     d. 8 từ 

Câu 19: Khi tổ chức lớp học bằng biện pháp giáo dục tích cực ( không dùng roi 

vọt, hình phạt ) thì học sinh sẽ: 

a. Tích cực và chủ động hơn trong học tập. 

b. Tự tin trước mọi người, khả năng của trẻ được phát huy. 
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c. Có cơ hội được chia sẻ, bày tỏ, được mọi người quan ta6mm tôn trọng và lắng nghe 

ý kiến. 

d. Cả 3 ý trên đều đúng. 

Câu 20: Tỉnh nào ở Tây Nguyên không có đường biên giới quốc gia ? 

a. Đăk Lăk          b. Gia Lai        c. Lâm Đồng          d. Kon Tum 

Câu 21: Tổng của hai số bằng 224. Biết 
3

1
 số thứ nhất bằng 

5

1
 số thứ hai. Tìm hai 

số đó. 

a. 64 và 160         b. 74 và 150         c. 84 và 140           d. 94 và 130 

Câu 22: UN là chữ viết tắc của tổ chức nào? 

a. APEC       b. Nhân đạo thế giới        c.Liên Hợp Quốc          d. ASEAN      

Câu 23: How many seasons are there in south Vietnam? 

a. 4                 b.  3                       c. 1                      d.  2    

Câu 24: 0,1, 2, 4, 6, 9, 12,16, ?What number should replase the question mark ? 

a. 18               b. 20                     c. 22                     d. 24 

Câu 25: Trong các câu sau đây, câu nào là câu kể Ai thế nào ? 

a. Ngọc là một cô bé ngoan hiền, biết phụ giúp ba mẹ lại học rất giỏi. 

b. Ở nhà, Ngọc không chỉ biết có học bài mà còn biết phụ giúp ba mẹ. 

c. Bé Ngọc rất siêng năng, vừa biết phụ giúp ba mẹ lại học rất giỏi. 

d. Không chỉ là một học sinh giỏi, Ngọc còn là một đứa con ngoan của ba mẹ. 

Câu 26: Trong các câu sau, câu nào là câu đơn đặc biệt vị từ ? 

a. Cắt tóc!              b. Máy bay!            c. Trường Sơn!                d.  Tre xanh! 

Câu 27: Đồng bằng Duyên hải miền Trung bị chia cắt thành nhiều đồng bằng 

nhỏ, là do: 

a. Các con sông bắt nguồn từ dãy Trường Sơn chảy ra biển. 

b. Do ranh giới các tỉnh miền Trung tự xây. 

c. Các nhánh núi từ dãy Trường Sơn đâm ra tận biển. 

d. Cả a, b, c.  

Câu 28: Tác nhân gây bệnh sốt xuất huyết là: 

a. Vi rút              b. Vi khuẩn       c. Kí sinh trùng          d. Muỗi vằn 

Câu 29: Muốn tạo tiêu đề đầu trang và tiêu đề chân trang trong Microsoft Word 

ta thực hiện: 

a. Chọn Menu Fomat View Header and Footer. 

b. Chọn Menu View Header and Footer. 

c. File Header and Footer. 

d. Tất cả đều đúng. 

Câu 30: Để chèn một công thức toán học vào văn bản, World có riêng một tiện 

ích cho công việc này, đó là: 

a. Microsoft Equation.                               c. Borders and Shading. 

b. Encrypt Easy.                                         d. Heared and Footer.   
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Câu 31: Dạy học Mĩ thuật ở Tiểu học có hiệu quả khi: 

a. Học sinh hứng thú học tập, cảm xúc về cái đẹp. 

b. Giáo viên tổ chức cho học sinh thảo luận nhóm. 

c. Học sinh có sáng tạo về cái đẹp. 

d. Cả a, b, c, đều sai. 

Câu 32: Hãy cho biết giá trị một nốt tròn bằng bao nhiêu nốt trắng ? 

a. 2 nốt                     b. 3 nốt               c. 4 nốt                 d. 5 nốt 

Câu 33: Quốc hiệu Việt Nam, chính thức công nhận vào năm và thời kì nào sau 

đây? 

a. Năm 1945, sau Cách mạng tháng Tám thành công. 

b. Năm 1428, sau 10 năm khởi nghĩa chống giặc toàn thắng của Lê Lợi. 

c. Năm 1802, mở đầu thời Nguyễn do vua Gia Long đề xướng. 

d. Năm 1976, ở kì họp đầu tiên của Quốc hội nước Việt Nam, sau khi đất nước thống 

nhất. 

Câu 34: Để cơ thể khỏe mạnh, bạn cần ăn thức ăn thuộc nhóm: 

a. Có nhiều chất bột và chất béo.           c. Có nhiều chất đạm. 

b. Có nhiều vitamin và khoáng.             d. Tất cả các loại trên. 

Câu 35: Hiện nay giáo viên thực hiện soạn giảng theo chuẩn kiến thức, kĩ năng 

và nội dung điều chỉnh dạy học các bộ môn. Một lần dự giờ thăm lớp phát hiện 

đồng nghiệp giáo viên giảng dạy phần nội dung giảm tải, thầy ( cô ) xử lí thế nào? 

a. Xem kĩ tài liệu hướng dẫn, góp ý cho đồng nghiệp cẩn thận nghiên cứu bài dạy 

đồng thời báo cho tổ trưởng xem lại hồ sơ giáo án của giáo viên nhắc nhở sửa chữa 

kịp thời những sai sót. 

b. Xem kĩ tài liệu hướng dẫn, góp ý đồng nghiệp soạn giáo án cẩn thận hơn. 

c. Không góp ý cho đồng nghiệp, trực tiếp báo cho hiệu trưởng biết sự việc xảy ra. 

d. Đưa ra tổ để tổ trưởng rút kinh nghiệm chung cho giáo viên trong tổ. 

Câu 36: Lá cây có chức năng gì? 

a. Hô hấp.       b. Thoát hơi nước.       c. Quang hợp.         d. Cả a, b, c . 

Câu 37: Trong phân môn Tập viết, mẫu chữ thường được chia  mấy nhóm ? 

a. 2 nhóm              b. 3 nhóm                c. 4 nhóm               d.5 nhóm 

Câu 38: Họa sĩ Tô Ngọc Vân được nhà nước tặng Giải thưởng Hồ Chí Minh về 

Văn học nghệ thuật năm nào? 

a. 1999                 b. 1997                    c. 1996                  d. 1995 

Câu 39: Nhiệm vụ dạy học thực hành kĩ thuật là: 

a. Hình thành và phát triển tư duy kĩ thuật và thực hiện các chức năng khác ( tác 

phong lao động, tạo hứng thú, an toàn vệ sinh… ). 

b. Củng cố, hoàn thiện, đào sâu, vận dụng kiến thức. 

c. Hình thành, rèn luyện kĩ năng, kĩ xảo kĩ thuật. 

d. Cả a, b, c. 
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Câu 40: Nhìn vào hình vẽ. Tính diện tích còn lại: 

            5,8 cm 

 

a. 33,64cm2 

b. 26,4074 cm2 

c. 7,2326 cm2 

d. 27,2326 cm2 

 

 

PHẦN II: Bài tự luận 

( Thời gian làm bài 50 phút. GV đọc kĩ đề bài và làm bài vào giấy thi do hội đồng 

cung cấp ) 

 

Đề bài:  

“ Chất lượng giáo dục” là đạo đức nghề nghiệp của mỗi nhà giáo. Là người đang trực 

tiếp giảng dạy, thầy ( cô ) hãy trình bày hiểu biết, quan điểm của bản thân để nâng cao 

chất lượng của lớp mình. 

 

 

                                                   - HẾT - 
 

 

 

 

YÊU CẦU – HƯỚNG DẪN CHẤM BÀI 

 

PHẦN I: Câu hỏi trắc nghiệm 

 

Đáp án:   Đề A 

1 2 3 4 5 6 7 8 9 10 

b b b d c d b d d a 

11 12 13 14 15 16 17 18 19 20 

b d b b a c b a d c 

21 22 23 24 25 26 27 28 29 30 

c c d b c a c a b c 

31 32 33 34 35 36 37 38 39 40 

a a c d a d b c d c 
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Đáp án:   Đề B 

 

1 2 3 4 5 6 7 8 9 10 

b d d b b a b b c a 

11 12 13 14 15 16 17 18 19 20 

d a b b d d a a b a 

21 22 23 24 25 26 27 28 29 30 

d c c c b c c c a b 

31 32 33 34 35 36 37 38 39 40 

b a c a a c d a d d 

 

PHẦN II: Bài tự luận 

I. Hình thức: ( 2 điểm ) 
 

- Bài viết có đủ 3 phần: mở bài, thân bài (phát triển) và kết luận. 

- Chữ viết chân phương, rõ ràng.  

- Không có nhiều hơn 3 lỗi chính tả hoặc lỗi dùng từ. 

II. Nội dung: Trình bày đủ các phần theo đề bài như sau: ( 8 điểm ) 

1. Hiểu biết về khái niệm chất lượng giáo dục. ( 1 điểm ) 

- Chất lượng là sản phẩm làm ra phù hợp với mục tiêu. 

- Chất lượng giáo dục là sự đáp ứng yêu cầu về mục tiêu giáo dục. 

- Nhận thức rõ chất lượng chuyên môn của giáo viên quyết định đến chất lượng 

giáo dục. 

2. Trình bày được những biện pháp đã và cần áp dụng để nâng cao chất lượng giáo 

dục( 2,5 điểm ) 

- Thực hiện chương trình, kế hoạch dạy học theo chuẩn kiến thức, kĩ năng. 

- Thực hiện tốt việc điều chỉnh nội dung dạy học. 

- Đổi mới phương pháp dạy học. Sử dụng công nghệ thông tin vào giảng dạy. 

- Phụ đạo hs yếu để củng cố kiến thức. 

- Quan tâm đến công tác bồi dưỡng học sinh giỏi. 

- Xây dựng cho hs tình cảm yêu trường, mến bạn tạo động lực để các em hăng hái thi 

đua học tập. Giáo dục kĩ năng sống cho hs. 

- Kiểm tra đánh giá kết quả giảng dạy của gv và học tập của hs. 

- Điều kiện cơ sở vật chất trường, lớp…. 

3. Dẫn chứng cách thức thực hiện và việc làm cụ thể. ( 3 điểm ) 

- Duy trì sĩ số. 

- Thực tiễn giảng dạy trong tiết học. 

- Khảo sát, thống kê đối tượng học sinh. 
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- Phân tích chất lượng học sinh. 

- Tiến hành phụ đạo, bồi dưỡng. 

- Lập sổ theo dõi. 

- Sau mỗi đợt kiểm tra định kì có phân tích chất lượng học sinh. Đối chiếu, so 

sánh qua từng giai đoạn. Nhận xét, đánh giá. 

- Tham gia dự giờ, thăm lớp, rút kinh nghiệm nâng cao tay nghề. 

- Phát huy lương tâm và trách nhiệm của nhà giáo. 

- Liên hệ với PHHS kịp thời về kết quả học tập của các em. 

- Phối hợp chặt chẽ giữa ba lực lượng: Nhà trường – gia đình – xã hội. 

- Nêu được kết quả của việc thực hiện - Minh chứng.  

4. Bài học kinh nghiệm sau khi thực hiện các biện pháp nâng cao chất lượng giáo dục. 

( 1,5 điểm ) 

- Gv có ảnh hưởng lâu dài đến thành tích học tập của hs. 

- Người gv phải có các kĩ năng cơ bản, có khối lượng kiến thức chung và việc 

thực hiện giảng dạy đúng yêu cầu, phải tự học tập, rèn luyện nâng cao tay nghề. 

- Đội ngũ gv chuẩn về nghề nghiệp, tốt về đạo đức, giỏi về chuyên môn, tận tâm 

với nghề và vững vàng về chính trị….. 

 

 

 

 

 

 
CÂU HỎI PHẦN THI KIẾN THỨC GIÁO VIÊN TIỂU HỌC 

(Nội dung về Chuẩn nghề nghiệp giáo viên tiểu học) 

 

I. PHẦN TRẮC NGHIỆM:  

 Khoanh vào chữ đứng trước ý trả lời đúng nhất của mỗi câu:  

1. Quy định về Chuẩn nghề nghiệp giáo viên tiểu học ban hành kèm theo văn bản nào 

dưới đây? 

a. Thông tư số 14/2011/TT-BGDĐT ngày 8/4/2011 của Bộ GD-ĐT 

b. Quyết định số 14/2007/QĐ-BGDĐT ngày 4/5/2007 của Bộ GD-ĐT 

c. Công văn số 10358/BGDĐ ngày28/9/2007 của Bộ GD-ĐT 

d. Thông tư 32/2009/TT-BGDĐT ngày 27/10/209 của Bộ GD-ĐT 

2. Chuẩn nghề nghiệp giáo viên tiểu học là: 

a.  Những yêu cầu của Bộ GD-ĐT đối với người giáo viên tiểu học. 

https://www.facebook.com/groups/tailieutieuhocvathcs/


hoc360.net – Tài liệu học tập miễn phí 
 

69                     Group: https://www.facebook.com/groups/tailieutieuhocvathcs/                        
 

b. Các yêu cầu về phẩm chất chính trị, đạo đức, lối sống; kiến thức; kỹ năng sư phạm 

và tiêu chuẩn xếp loại; quy trình đánh giá, xếp loại giáo viên tiểu học. 

c. Hệ thống các yêu cầu cơ bản về chất chính trị, đạo đức, lối sống; kiến thức; kỹ năng 

sư phạm mà giáo viên tiểu học cần phải đạt được nhằm đáp ứng mục tiêu của giáo 

dục tiểu học. 

d. Tất cả các ý trên. 

3. Mục đích của việc ban hành Chuẩn nghề nghiệp giáo viên tiểu học là gì? 

a. Làm cơ sở để xây dựng, đổi mới nhiệm vụ, mục tiêu đào tạo, bồi dưỡng giáo viên 

tiểu học. Giúp giáo viên tiểu học tự đánh giá năng lực nghề nghiệp, từ đó xây dựng 

kế hoạch học tập, rèn luyện và phấn đấu.  

b. Làm cơ sở để đánh giá giáo viên tiểu học hằng năm phục vụ công tác quy hoạch, sử 

dụng và bồi dưỡng đội ngũ giáo viên tiểu học. 

c. Làm cơ sở để giáo viên đăng kí giáo viên dạy giỏi các cấp.  

d. Ý a và ý b đúng 

4. Chuẩn nghề nghiệp giáo viên tiểu học gồm mấy lĩnh vực? 

a. 2 lĩnh vực 

b. 3 lĩnh vực 

c. 4 lĩnh vực 

d. 5 lĩnh vực 

5. Chuẩn nghề nghiệp giáo viên tiểu học bao gồm các lĩnh vực sau:  

a. Phẩm chất chính trị, đạo đức, lối sống; kiến thức; kỹ năng sư phạm 

b. Phẩm chất chính trị; kiến thức và kỹ năng sư phạm 

c. Phẩm chất về kiến thức và kỹ năng sư phạm 

d. Phẩm chất chính trị, đạo đức, lối sống và kỹ năng sư phạm 

6. Tiêu chí “Phối hợp với gia đình và các đoàn thể địa phương để theo dõi, làm công tác 

giáo dục học sinh” thuộc lĩnh vực nào của Chuẩn nghề nghiệp giáo viên tiểu học? 

a. Phẩm chất chính trị, đạo đức, lối sống 
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b. Kiến thức 

c. Kỹ năng sư phạm 

d. Không thuộc lĩnh vực nào cả 

7. Tiêu chí “Có khả năng soạn được các đề kiểm tra theo yêu cầu chỉ đạo chuyên môn, 

đạt chuẩn kiền thức, kỹ năng môn học và phù hợp với các đối tượng học sinh” thuộc lĩnh 

vực nào của Chuẩn nghề nghiệp giáo viên tiểu học? 

a. Phẩm chất chính trị, đạo đức, lối sống 

b. Kiến thức 

c. Kỹ năng sư phạm 

d. Không thuộc lĩnh vực nào cả 

8. Tổ chức đánh giá, xếp loại giáo viên tiểu học theo Chuẩn nghề nghiệp vào thời điểm: 

a. Đầu năm học 

b. Cuối năm học 

c. Cuối học kì I và cuối năm học 

d. Do nhà trường chọn thời điểm phù hợp 

9. Đánh giá, xếp loại giáo viên tiểu học theo Chuẩn nghề nghiệp gồm các mức độ sau: 

a. Xuất sắc; tốt; khá; trung bình 

b. Tốt; khá; trung bình; kém 

c. Tốt; khá; trung bình; chưa đạt yêu cầu 

d. Xuất sắc; khá; trung bình; kém 

10. Một giáo viên được đánh giá, xếp loại chung theo Chuẩn nghề nghiệp đạt loại Xuất 

sắc cần phải: 

a. Cả 3 lĩnh vực đều phải được xếp loại tốt 

b. Các lĩnh vực đều xếp loại tốt, trong đó phải có 1 lĩnh vực xếp loại xuất sắc 

c. Có 2 lĩnh vực xếp loại tốt, 1 lĩnh vực xếp loại khá 

d. Có 2 lĩnh vực xếp loại xuất sắc 
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11. Giáo viên bị xếp loại “Kém” theo Chuẩn nghề nghiệp khi: 

a. Có một trong 3 lĩnh vực xếp loại kém 

b. Xúc phạm danh dự, nhân phẩm, xâm phạm thân thể người khác 

c. Gian lận trong thi cử, cố ý đánh giá sai kết quả học tập của học sinh 

d. Các ý trên đều đúng 

12. Một giáo viên được hiệu trưởng dự giờ 1 tiết Tiếng Việt, 1 tiết Toán, 1 tiết trong các 

môn còn lại đều không đạt yêu cầu. Cuối năm học, hiệu trưởng xếp loại giáo viên này 

loại “Kém” là đúng hay sai? 

a. Đúng 

b. Sai 

13. Trong trường hợp chưa đồng ý với đánh giá, xếp loại theo Chuẩn nghề nghiệp của 

hiệu trưởng, giáo viên có quyền khiếu nại lần đầu tiên với:  

a. Hiệu trưởng 

b. Hội đồng trường 

c. Chủ tịch công đoàn cơ sở 

d. Trưởng phòng Phòng GD-ĐT 

14. Trong trường hợp giáo viên được đánh giá theo Chuẩn nghề nghiệp cận với mức độ 

tốt, khá hoặc trung bình, việc xem xét nâng mức hay giữ nguyên dựa trên sự phấn đấu 

của mỗi giáo viên, hiệu trưởng nhà trường quyết định những trường hợp cụ thể và chịu 

trách nhiệm về quyết định đó, đều này đứng hay sai?  

a. Đúng 

b. Sai 

15. Tiêu chuẩn để xếp loại “Tốt” các lĩnh vực của Chuẩn nghề nghiệp là: 

a. 200 điểm 

b. 180 điểm 

c. Từ 140 đến 179 điểm 
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d. Từ 180 đến 200 điểm 

16. Một giáo viên được xếp loại cả ba lĩnh vực là loại “Tốt”, vậy xếp loại chung Chuẩn 

nghề nghiệp của giáo viên này là: 

a. Tốt 

b. Khá 

c. Xuất sắc 

d. Trung bình 

17.  Một giáo viên có hành vi xâm phạm thân thể học sinh, giáo viên này đã nhận lỗi với 

gia đình học sinh và trước hội đồng trường. Giáo viên này nên tự đánh giá, xếp loại 

Chuẩn nghề nghiệp là: 

a. Trung bình 

b. Tốt 

c. Khá 

d. Kém 

18. Hiệu trưởng xếp loại chung Chuẩn nghề nghiệp của một giáo viên là “Tốt”, kết quả 

xếp loại này là:  

a. Đúng 

b. Sai 

19. Điểm tối đa mỗi tiêu chí của Chuẩn nghề nghiệp là: 

a. 40 

b. 100 

c. 10 

d. 200 

20. Một giáo viên tự xếp loại có hai lĩnh vực loại “Tốt” và một lĩnh vực loại “Trung bình”, 

xếp loại chung của Chuẩn nghề nghiệp là: 

a. Tốt 

b. Trung bình 

c. Khá 

d. Xuất sắc 
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II. CÂU HỎI TỰ LUẬN 

1. Theo anh (chị) hiểu như thế nào về Chuẩn nghề nghiệp giáo viên tiểu học? Việc đánh giá, 

xếp loại giáo viên theo Chuẩn nghề nghiệp giáo viên tiểu học hiện nay là cần thiết hay 

không? Vì sao? 

2. Có người nói Chuẩn nghề nghiệp giáo viên chủ yếu dùng để làm điều kiện được dự thi 

giáo viên dạy giỏi các cấp. Anh (chị) có đồng tình với quan điểm trên không? Vì sao? 

3. Anh (chị) hãy trình bày quy trình đánh giá, xếp loại giáo viên theo Chuẩn nghề nghiệp 

giáo viên tiểu học ở đơn vị trong thời gian qua. Điểm nào phù hợp, chưa phù hợp, những đề 

xuất của anh (chị) để việc đánh giá, xếp loại giáo viên theo Chuẩn nghề nghiệp mang lại hiệu 

quả cao như mục đích khi ban hành Chuẩn.  

 

 

                   KẾT QUẢ CÂU HỎI TRẮC NGHIỆM 

 

Câu hỏi Ý đúng Câu hỏi Ý đúng 

1 b 11 d 

2 c 12 a 

3 d 13 b 

4 a 14 a 

5 b 15 d 

6 c 16 c 

7 b 17 d 

8 b 18 b 

9 d 19 c 

10 a 20 b 
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 CÂU HỎI TRẮC NGHIỆM 
A/ Hãy chọn (khoanh tròn) một đáp án đúng nhất cho từng câu dưới đây: 

Câu 1: Điều nào không thuộc nguyện tắc đánh giá và xếp loại học sinh: 
a. Thực hiện công khai, công bằng, khách quan, chính xác và toàn diện. 

b. Coi trọng việc động viên, khuyến khích sự tiến bộ của HS. 

c. Phát hiện và bồi dưỡng HS giỏi, HS năng khiếu. 

d. Kết hợp đánh giá định lượng và định tính trong đánh giá và xếp loại. 

 

Câu 2: Ý nào sau đây đúng khi nói về “Hội đồng trường” ở cấp Tiểu học: 
a. Chủ tịch Hội đồng trường công lập không nhất thiết là Hiệu trưởng. 

b. Chủ tịch Hội đồng trường công lập không đồng thời là Hiệu trưởng. 

c. Chủ tịch Hội đồng trường công lập đồng thời là Hiệu trưởng trường. 

d. Chủ tịch Hội đồng trường công lập nhất thiết là Hiệu trưởng trường. 

 

Câu 3 : Trong trường hợp chưa đồng ý với kết luận của hiệu trưởng, GV có 

quyền khiếu nại với : 

a. Chủ tịch công đoàn                         b. Thanh tra nhân dân 

c. Chủ tịch hội đồng trường                d. Hội đồng sư phạm 

 

Câu 4 : Câu nào sau đây “sai” : 

a. Đánh giá hạnh kiểm HKII của HS cũng là đánh giá hạnh kiểm cuối năm học HS đó 

b. Đối với môn được đánh giá bằng nhận xét, HLM.N chính là HLM.KII 

c. Môn tin học, tiếng Anh không tham vào xét lên lớp HS. 

 

Câu 5: Câu nào sâu đây “sai ” : 

a. Hạnh kiểm HS được đánh giá gồm hai loại: Đ và CĐ.  

b. HS được đánh giá hạnh kiểm ba lần: HKI, HKII và cả năm học. 

c. HS được đánh giá hạnh kiểm hai lần: cuối HKI và cuối năm học. 

d. Đánh giá hạnh kiểm cuối năm là quan trọng nhất. 

 

Câu 6 : Giáo dục hòa nhập được hiểu là : 

a. Giáo dục cho trẻ khuyết tật      b. GD cho trẻ khiếm khuyết về ngôn ngữ, trẻ em 

đường phố 

c. Giáo dục hòa nhập là dành cho tất cả mọi trẻ em, kể cả trẻ khuyết tật 

 

 

Câu 7 : Trình độ chuẩn được đào tạo của GV tiểu học hiện nay là : 

a. Có bằng tốt nghiệp trung cấp sư phạm               b. Có bằng tốt nghiệp cao đẳng sư 

phạm 

c. Có bằng tốt nghiệp đại học sư phạm                  d. Một đáp án khác 
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Câu 8 : Thời gian đánh giá xếp loại GV :  

a. Giữa năm học      b. Cuối kỳ I       c. Cuối năm học         d. Xuyên suốt cả quá trình 

 

Câu9 : Các môn học đánh giá bằng điểm số gồm :  

a. Toán, Tiếng Việt, Khoa Học, Lịch Sử và Địa Lý 

b. Toán, Tiếng Việt, Khoa Học, Lịch Sử và Địa Lý, tiếng nước ngoài 

c. Toán, Tiếng Việt, Khoa Học, Lịch Sử và Địa Lý, tiếng nước ngoài, tiếng dân tộc 

d. Toán, Tiếng Việt, Khoa Học, Lịch Sử và Địa Lý, tiếng nước ngoài, tiếng dân tộc và 

nội dung tự chọn 

 

Câu 10 : Các mô hình giáo dục HS khuyết tật : 

a. Giáo dục chuyên biệt, giáo dục hội nhập            b. Giáo dục chuyên biệt, giáo dục 

hòa nhập 

c. Giáo dục chuyên biệt, giáo dục hội nhập, giáo dục hòa nhập 

 

Câu 11 : Quy định chuẩn nghề nghiệp theo QĐ 14/BGD-ĐT áp dụng : 

a. Cho tất cả GV thuộc loại hình GD quốc dân        b. Cho GV đang dạy tại các trường 

phổ thông 

c. Cho GVTH tại cơ sở GD phổ thông trong hệ thống GD quốc dân  

 

Câu 12 : Chuẩn nghề nghiệp GVTH có ba lĩnh vực : phẩm chất chính trị đạo đức 

lối sống – kiến thức – kĩ năng sư phạm; xếp loại kém khi : 

a. Có 3 lĩnh vực xếp loại kém         b. Có 2 lĩnh vực xếp loại kém     

c. Có 1 trong 3 lĩnh vực xếp loại kém 

 

Câu 13 : Đánh giá kết quả GD đối với HS ở các môn học và hoạt động GD trong 

mỗi lớp được căn cứ vào : a. QĐ 30/ BGD-ĐT   b. QĐ 14/BGD-ĐT     c. QĐ 

16/BGD-ĐT  d. QĐ 32/ BGD-ĐT 

 

Câu 14 : Điều gì có thể giúp giáo viên làm tốt công tác chủ nhiệm của mình : 

a. Sự mẫu mực của bản thân và tấm lòng yêu thương học sinh của thầy cô giáo .Và sự 

giáo dục hạnh kiểm cho các em hằng ngày. 

b. Sự giúp đỡ của phụ huynh và hỗ trợ của BGH cùng các tổ chức đoàn thể trong nhà 

trường. 

c. Bằng  uy thế của bản thân và những danh hiệu mà người thầy được khen tặng . 

d. Bằng kỷ cương nề nếp của lớp và của nhà trường. 

 

Câu 15 : Biện pháp nào sau đây có thể  hữu hiệu đối với những học sinh lười học 

hoặc thường xuyên có hành vi vi phạm nề nếp kỷ cương : 
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a. Cảnh cáo trước lớp và toàn trường. 

b. Phân tích lỗi lầm , bắt quỳ gối hoặc đánh đòn. 

c. Phân tích lỗi lầm và dọa sẽ đuổi học. 

d. Phân tích lỗi lầm và buộc phải chép nhiều lần bài đã học. 

 

Câu 16 : Giáo viên tiểu học thường kính phục xếp mình bởi điều gì sau đây : 

a. Thân thế . 

b. Tài năng. 

c. Yêu thương đồng nghiệp. 

d. Yêu thương học sinh. 

 
B/ Bạn hãy đọc kĩ 10 nội dung dưới đây điền dấu chéo vào ô trống tương ứng với ý mà anh 
(chị) cho là đúng (Đ) hoặc sai (S). Mỗi ý chỉ đánh chéo vào một ô, không được tẩy xóa bỏ. 

 

TT Nội dung Đ S 

1 Giáo viên cho điểm KTTX môn Toán lớp Hai 3 lần trong 

một tháng. 

  

2 Môn tiếng nước ngoài đánh giá bằng điểm số.   

3 QĐ 30/BGD-ĐT quy định học sinh được đánh giá hạnh kiểm 

vào thời điểm cuối kỳ I và cuối năm học. 

  

4 Chuẩn kiến thức, kĩ năng HS tiểu học được biên soạn trên cơ 

sở     QĐ 30/BGD-ĐT. 

  

5 Rèn luyện kĩ năng sống cho HS là một trong năm nội dung 

của trường học thân thiện. 

  

6 Mô hình trường học thân thiện được Bộ GD-ĐT áp dụng đại 

trà cho các trường TH và THCS trên toàn quốc vào năm học 

2008 – 2009. 

  

7 Môn Tiếng Việt có 2 lần kiểm tra Đọc – Viết, điểm của 2 lần 

này được làm tròn và quy về một điểm chung là trung bình 

cộng (làm tròn 0,5 thành 1). 

  

8 QĐ 30/BGD-ĐT qui định khen thưởng cho HS đạt HLM.N 

của từng môn đạt loại giỏi. 

  

9 HS khuyết tật học hòa nhập được đánh giá KTTX và định kỳ 

nếu HS có khả năng học tập môn đó một cách bình thường. 

  

10 Kiểm tra, đánh giá thường xuyên môn Tiếng Việt bao gồm 

những hình thức : kiểm tra miệng, quan sát HS học tập, 

thông qua bài tập, kiểm tra viết. 

  

 

 

KÌ THI GIÁO VIÊN GIỎI CẤP TRƯỜNG 
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Năm học:  2012-2013 

Ngày 06 tháng 10 năm 2012 

ĐỀ 1  

A. PHẦN TRẮC NGHIỆM:  

 Khoanh tròn vào phiếu làm bài thi trắc nghiệm ý trả lời đúng nhất:  

1. Học sinh học hết chương trình tiểu học có đủ điều kiện theo quy định của Bộ trưởng 

Bộ Giáo dục và Đào tạo được ai xác nhận trong học bạ Hoàn thành chương trình tiểu 

học? 

 a. Giáo viên chủ nhiệm   b. Phó Hiệu trưởng phụ trách chuyên môn 

 c. Hiệu trưởng    d. Cả a, b, c đều sai 

2. Tham gia công tác phổ cập giáo dục ở địa phương là nhiệm vụ của ai? 

 a. Hiệu trưởng    b. Phó Hiệu trưởng 

 c. Giáo viên     d. Tổng phụ trách 

3. Người chịu trách nhiệm chính trong việc đánh giá, xếp loại học sinh theo quy định là: 

a. Hiệu trưởng    b. Phó Hiệu trưởng 

c. Giáo viên chủ nhiệm   d. Cả a, b, c đều đúng 

4. Thông tư số 41/2010/TT-BGDĐT ngày 30 tháng 12 năm 2010 của Bộ trưởng Bộ Giáo 

dục và Đào tạo ban hành về nội dung gì? 

a. Quy định về Chuẩn nghề nghiệp Giáo viên tiểu học. 

b. Điều lệ trường tiểu học. 

c. Quy chế đánh giá xếp loại học sinh tiểu học. 

d. Điều lệ Tổ chức Hội thi Giáo viên dạy giỏi. 

5. Theo Điều lệ của trường tiểu học, tuổi của học sinh tiểu học từ  : 

 a. 6 tuổi đến 10 tuổi    b. 6 tuổi  đến 12 tuổi 

 c. 6 tuổi đến 14 tuổi    d. 6 tuổi đến 15 tuổi  

6. Chuẩn trình độ đào tạo của giáo viên Tiểu học là :  

 a. Có bằng tốt nghiệp trung cấp sư phạm  

 b. Có bằng tốt nghiệp cao đẳng sư phạm 

 c. Có bằng tốt nghiệp đại học sư phạm 

 d. Cả a, b, c đều đúng 

7. Học sinh được đánh giá về hạnh kiểm theo kết quả rèn luyện đạo đức và kĩ năng 

sống qua việc thực hiện mấy nhiệm vụ của học sinh tiểu học? 

 a. 4 nhiệm vụ    b. 5 nhiêm vụ 

 c. 6 nhiệm vụ    d. Cả a, b, c đều sai 

8. Đối với học sinh khuyết tật không đủ khả năng đáp ứng các yêu cầu của chương 

trình giáo dục chung được đánh giá dựa trên cơ sở : 

a.  Dựa  trên các tiêu chí của học sinh bình thường nhưng có giảm nhẹ về yêu cầu. 

b. Dựa trên sự tiến bộ của học sinh. 

c. Chỉ đánh giá dựa trên kết quả của 2 môn Toán và Tiếng Việt, không đánh giá các 

môn còn lại. 

d. Dựa trên nguyên tắc động viên, khuyến kích và ghi nhận sự tiến bộ của người học; 

không xếp loại đối tượng này. 

9.  Một học sinh có kết quả học tập cuối năm như sau: 
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Toán: Khá – Tiếng Việt: Khá – Các môn đánh giá bằng nhận xét: đạt A 

Theo Thông tư 32 học sinh đó sẽ được xét khen thưởng danh hiệu : 

 a. Học sinh giỏi    b. Học sinh xuất sắc 

 c. Học sinh khá    d. Học sinh tiên tiến 

10. Theo qui định hiện hành, khi tiến hành kiểm tra đánh giá ra đề thi kiểm tra định kì 

giáo viên căn cứ chủ yếu vào: 

 a. Sách giáo khoa và sách bài tập 

 b. Sách giáo khoa và sách giáo viên 

 c. Sách tham khảo 

 d. Chuẩn kiến thức, kĩ năng của chương trình. 

11. Theo thông tư 32/ 2009/TT-BGDĐT ngày 27/10/2009 quy định số lần kiểm tra 

thường xuyên tối thiểu trong một tháng của môn Toán là :  

 a. 2 lần  b. 3 lần   c. 4 lần   d. 5 lần  

12. Thông tư số  32 /2009/TT-BGDĐT ngày 27 tháng 10  năm 2009 của Bộ trưởng Bộ 

Giáo dục và Đào tạo qui định về nguyên tắc đánh giá và xếp loại gồm:  

 a. 2 nguyên tắc                b. 3 nguyên tắc                 

 c. 4 nguyên tắc                   d. 5 nguyên tắc 

13. Theo Thông tư 32/2009/TT-BGDĐT Học sinh được xếp loại giáo dục theo mấy loại? 

  a. 3 loại: Giỏi, trung bình, yếu 

  b. 3 loại: Xuất sắc, tiên tiến, trung bình 

  c. 4 loại: Giỏi, khá, trung bình, yếu 

  d. 4 loại: Giỏi, tiên tiến, trung bình, yếu. 

14. Việc hoàn thành hồ sơ về đánh giá xếp loại học sinh cuối năm là trách nhiệm của :  

  a. Hiệu trưởng   b. Phó Hiệu trưởng 

  c. Giáo viên chủ nhiệm d. Cả a, b, c  

15.  Các hành vi giáo viên không được làm là: 

a. Xúc phạm danh dự, nhân phẩm, xâm phạm thân thể học sinh và đồng nghiệp. Xuyên tạc 

nội dung giáo dục; dạy sai nội dung, kiến thức, không đúng với quan điểm, đường lối giáo 

dục của Đảng và Nhà nước Việt Nam. Cố ý đánh giá sai kết quả học tập, rèn luyện của học 

sinh. 

b . Ép buộc học sinh học thêm để thu tiền. Uống rượu, bia, hút thuốc lá khi tham gia 

các hoạt động giáo dục ở nhà trường, sử dụng điện thoại di động khi đang giảng dạy trên lớp. 

Bỏ giờ, bỏ buổi dạy, tuỳ tiện cắt xén chương trình giáo dục. 

c. Cả a và b đều đúng. 

d. Cả a và b đều sai. 

16. Chuẩn kiến thức kĩ năng trong chương trình giáo dục là:  

 a. Là mức tối thiểu về kiến thức kĩ năng mà người học phải đạt được sau khi kết thúc 

một chương trình giáo dục. 

 b. Là mức tối đa về kiến thức kĩ năng mà người học phải đạt được sau khi kết húc một 

chương trình giáo dục. 

 c. Là toàn bộ nội dung, chương trình mà người học phải đạt sau một năm học. 

 d. Là toàn bộ nội dung chương trình mà người học phải đạt sau khi kết thúc một khóa 

học.  
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17. Theo anh, chị điều chỉnh dạy học là gì? 

 a. Biên soạn lại toàn bộ chương trình dạy học theo chỉ đạo của nhà trường. 

 b. Tăng giảm phân phối chương trình giảng dạy theo ý mình. 

 c. Dựa vào trình độ thực tế của học sinh mà lựa chọn phương pháp, nội dung và thời 

lượng giảng dạy cho phù hợp. 

 d. Cả a, b, c đều đúng 

18. Cách dạy học của giáo viên được xem là phát huy tính tích cực trong học tập của 

học sinh khi: 

 a. Tạo điều kiện để học sinh tìm tòi tiếp nhận tri thức, chủ động chiếm lĩnh tri thức. 

 b. Chú ý hình thành khả năng tự học của học sinh. 

 c. Coi trọng việc tổ chức các hoạt động của học sinh  

 d. Cả 3 ý trên đều đúng. 

19. Phương pháp giáo dục Tiểu học phải : 

 a. Phát huy được tính tích cực tự giác, chủ động, sáng tạo của học sinh. 

 b. Phù hợp với đặc trưng môn học, hoạt động giáo dục, đặc điểm đối tượng học sinh 

và điều kiện của từng lớp học 

 c. Bồi dưỡng cho học sinh phương pháp tự học, khả năng hợp tác; rèn luyện kĩ năng 

vận dụng kiến thức vào thực tiễn  

 d. Cả a ,b,c đều đúng  

20. Các lĩnh vực để đánh giá , xếp loại một tiết dạy của GV tiểu học ( theo phiếu dự giờ) 

 a. Kiến thức, kĩ năng, thái độ  

 b. Kiến thức, Kĩ năng sư phạm, thái độ sư phạm 

 c. Kiến thức, Kĩ năng sư phạm, thái độ sư phạm, hiệu quả 

 d. Cả a, b, c đều sai 

21. Tỉ lệ điểm dành cho các mức độ nhận thức so với tổng số điểm phù hợp theo chuẩn 

kiến thức, kĩ năng và yêu cầu về thái độ ở từng bộ môn đảm bảo tỉ lệ chung như sau ? 

 a. Nhận biết 50%, thông hiểu 30%, vận dụng 20%. 

 b. Nhận biết 60%, thông hiểu 30%, vận dụng 10%. 

 c. Nhận biết 40%, thông hiểu 40%, vận dụng 20%. 

 d. Nhận biết 40%, thông hiểu 30%, vận dụng 30%. 

22. Chương trình  tiếng Anh lớp Ba, Bốn trường đang dạy trong năm học 2012 - 2013 

là:  

 a. Let's go       

 b. Let's learn 

 c. Sách tiếng Anh của Bộ Giáo dục và Đào tạo    

 d. Cả a, b, c đều đúng. 

23.  Muốn tạo tiêu đề đầu trang và tiêu đề chân trang trong Microsoft Word ta thực 

hiện như thế nào ? 

 a. Chọn Menu Format → View → Header and Footer 

 b. Chon Menu View → Header and Footer 

 c. File → Header and Footer 

 d. Tất cả đều đúng. 
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24.  Để sao chép các tập tin hoặc các Folder trong Windows Explorer ta có các cách 

sau: 

 a. Edit → Copy   b. Ctrl + C 

 c. Click phải → Copy  d. Tất cả đều đúng 

25. Kết quả của dãy tính 1 x 3 x 5 x ......x 11   có chữ số hàng đơn vị là:               

 a. 0    b. 1 

 c. 9    d. 5 

26. Nếu 2 thợ may làm trong 2 giờ được 2 cái áo thì 4 thợ may (như thế) làm trong 4 giờ 

được bao nhiêu cái áo?  

 a. 4 cái áo    b. 8 cái áo 

 c. 12 cái áo   d. 16 cái áo 

27. Một con thuyền đậu trên sông, mũi thuyền cao hơn mặt nước 50cm. Hỏi khi nước 

sông dâng cao 27cm thì mũi thuyền cao hơn mặt nước bao nhiêu cm? 

 a. 23 cm                     b. 77cm                         c.  50 cm                      d.  27cm  

28. Với các chữ số 1, 2, 3 có thể viết được bao nhiêu số có 3 chữ số khác nhau và chia 

hết cho 5? 

 a. 0 số    b. 1 số  

 c. 2 số   d. 3 số 

29.  Năm nào sau đây là năm nhuận ? 

 a. 2011  b. 2012  c. 2013    d. 2014 

30. Các môn học Nghệ thuật ở khối 1, 2, 3 là: 

a.  Mĩ thuật. âm nhạc, thủ công 

b.  Mĩ thuật, âm nhạc, kĩ thuật 

c.  Mĩ thuật, âm nhạc 

d.  Mĩ thuật, thủ công  

31. Một nốt đen bằng mấy nốt đơn? 

 a. 1   b. 2  c. 3  d. 4 

32. Choose one word that is different from the others. 

  a. A cat  b. A dog   c. A chicken   d. A  lion 

33.  Địa chỉ trang web tổ chức thi "Giao thông thông minh"  trên Internet là: 

a.  violympic.com.vn  c.   ioe.vn 

      b.  violympic.com   d. ioe.com.vn 

34. Thống kê tình hình phổ cập đúng độ tuổi đầu năm học của lớp 2/1 như bảng: 

 7 tuổi 8 tuổi 9 tuổi Cộng Tỉ lệ phổ cập đúng độ tuổi 

Nam 20 3 1 24 60% 

Nữ 15 1  16 42,85% 

Cả lớp 35 4 1 40 87,5% 

  Giáo viên chủ nhiệm lớp đã tính tỉ lệ % ở dòng nào đúng? 

a) Nam   b) Nữ   c) Cả lớp   d) Tất cả cột tỉ lệ. 

35. Căn cứ vào đặc điểm của từng chữ cái, các nét đồng dạng giữa các chữ, kích thước 

quy trình viết, người ta chia chữ thường theo mấy nhóm? 

 a. 2 nhóm  b. 3 nhóm  c. 4 nhóm  d. 5 nhóm 

36. Phần đất liền nước ta có diện tích khoảng : 
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 a. 300.000 km2 b. 310.000 km2 c. 320.000 km2 d. 330.000 km2 

37. Theo tinh thần đổi mới phương pháp, việc dạy học môn Đạo đức dựa vào :  

 a. Quyền trẻ em 

 b. Trách nhiệm của học sinh 

 c. Bổn phận của học sinh 

 d. Trách nhiệm và bổn phận của học sinh 

38. Phương pháp nào sau đây không sử dụng trong dạy học Mĩ Thuật: 

 a. Phương pháp quan sát.                  c. Phương pháp trực quan. 

 b. Phương pháp làm việc theo cặp ,nhóm.     d. Phương pháp sắm vai 

39. Hiện tượng nào sau đây được gọi là sự biến đổi hoá học ? 

 a. Đun nóng đường. 

 b. Pha muối vào đường. 

 c. Pha đường với nước. 

 d. Bẻ gãy viên phấn. 

40. Tháng an toàn giao thông quốc gia hàng năm được tổ chức vào:   

 a. Tháng 8   b. Tháng 9   c.  Tháng 10   d. Tháng 11 

HẾT 
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